
Chapter 4

Datums

After completing this chapter you will be able to:

• Understand the three default datum planes.
• Create the datum planes using different constraints available.
• Create datums on the fly.
• Create datum axes using the different constraints available.
• Create the datum points.
• Create extrude and revolve cuts.

Learning Objectives
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DATUMS
Datums are imaginary features with no mass or volume and are available to help you in creating
a model, they act as reference for sketching of a feature, orientation of a model, assembling
components, and so on. Remember that the datums play a very important role in
creating complex models in Pro/ENGINEER and therefore you must have a good understanding
of datums. Datums are considered to be features but not model geometry. In Pro/ENGINEER,
datums exist as datum plane, datum curve, datum point, datum coordinate system, datum
graph, and so on.

Default Datum Planes
When you enter the Part mode or the Assembly mode, the three datum planes are by
default displayed on the graphics screen. These datum planes are mutually perpendicular to
each other. These are known as the default datum planes. The only difference between the
default datum planes of the Part mode and those of the Assembly mode lies in the names of
the datum planes.

The default datum planes in the Part mode are named as FRONT, TOP, and RIGHT. In case
of Assembly mode, the default datum planes are named as ASM_FRONT, ASM_TOP, and
ASM_RIGHT. However, the names of the default datum planes can be changed as required.
To change the names, choose PART > Set Up > Name. You will be prompted to select a
feature to change the name. Select the datum plane you want to rename. When the Message
Input Window appears, enter the desired name in this window.

There are two sides of a datum plane, colored yellow and red. Generally, the protrusion takes
place toward the yellow side of the datum plane and the cut takes place towards the red side.
This is the reason, while extruding a section, by default, the red arrow always points out of the
screen. You can change the colors of the datum planes according to your convenience. The
colors of the datum planes help in identifying the direction of feature orientation.

NEED FOR DATUMS IN MODELING
Generally, most of the engineering components or designs consist of more than one feature.
First the base feature of the model is created and then the other features of the model are
created. Since all the features of a model cannot be drawn on a single plane, therefore, to draw
the rest of the features sometimes additional planes have to be created or selected. Also, most
of the times the three default datum planes are not enough to create a complex model having
many features. For example, Figure 4-1 shows a simple model that consists of two features that
require two different planes.

In Figure 4-1 any of the two features that are defined on two different planes can be considered
as the base feature. However, in this discussion the base feature that is decided to be created is

Tip: Whenever you come across any solid model, first try to visualize the number of
features in that model and then decide which feature in the model you consider as the
base feature.
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mshown in Figure 4-2. After creating the base feature, the next feature has to be created. For the

next feature, a sketching plane has to be defined. Therefore, an additional plane will be created
on which you can draw the sketch for the second feature.

As shown in Figure 4-3, the plane that is used for the creation of the base feature is highlighted
by a mesh. To create the second feature, a new plane is created that is shown in Figure 4-4. The
sketch of the second feature is drawn on this plane and this is the reason, the front planar
surface is coplanar with the datum plane.

DATUM OPTIONS
After discussing the default datum planes that are the first feature in the Part mode, you must
know the different features created using the datum options. Datums are also considered as
features that have no geometry. Figure 4-5 shows the Datum toolbar. Figure 4-6 shows the
method of invoking different types of datum features from the menu bar.

Figure 4-2  Base feature of the modelFigure 4-1  Model having two extruded features

Figure 4-4  Plane selected for the second featureFigure 4-3  Plane selected for the base feature
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Datum Planes
We can create datum planes other than the three default datum planes using the menu bar or
the Datum toolbar. The datum planes can be created at anytime when required. The display of
the datum planes can be turned on or off by using the Datum planes on/off button from the
Datum Display toolbar. Before discussing the procedure to create the datum planes using the
different options, it is important for you to understand the use of datum planes. Some of the
uses of datum planes are listed below:

1. Datum planes are used as sketching planes to create sketches for the different features of
a model.

2. Datum planes are used as reference planes for sketching.

3. Datum planes are used as references for placing holes and for assembly.

4. Datum planes are used as a reference for mirroring features, copying features, for creating
a cross-section, and as well as for orientation of references.

Figure 4-6  Invoking the datum options from the Insert
menu in the menu bar

Figure 4-5  Datum toolbar



Datums        4-5

©
 C

A
D

C
IM

 T
©

 C
A

D
C

IM
 T

©
 C

A
D

C
IM

 T
©

 C
A

D
C

IM
 T

©
 C

A
D

C
IM

 T
e

ch
n
o

lo
g

ie
s,

 U
S

A
e

ch
n
o

lo
g

ie
s,

 U
S

A
e

ch
n
o

lo
g

ie
s,

 U
S

A
e

ch
n
o

lo
g

ie
s,

 U
S

A
e

ch
n
o

lo
g

ie
s,

 U
S

A
. 

F
. 

F
. 

F
. 

F
. 

F o
r 

e
n
g

in
e

e
ri

n
g

 s
e

r
o

r 
e

n
g

in
e

e
ri

n
g

 s
e

r
o

r 
e

n
g

in
e

e
ri

n
g

 s
e

r
o

r 
e

n
g

in
e

e
ri

n
g

 s
e

r
o

r 
e

n
g

in
e

e
ri

n
g

 s
e

r v
ic

e
s,

 c
o

nt
a

ct
 s

a
le

s@
ca

d
ci

m
.c

o
m

vi
ce

s,
 c

o
nt

a
ct

 s
a

le
s@

ca
d

ci
m

.c
o

m
vi

ce
s,

 c
o

nt
a

ct
 s

a
le

s@
ca

d
ci

m
.c

o
m

vi
ce

s,
 c

o
nt

a
ct

 s
a

le
s@

ca
d

ci
m

.c
o

m
vi

ce
s,

 c
o

nt
a

ct
 s

a
le

s@
ca

d
ci

m
.c

o
mPro/ENGINEER provides you with different options to create datum planes other than the

default datum planes. With this release of Pro/ENGINEER, datums can even be created while
you are in the sketcher environment. When you choose Insert > Datum > Plane from the
menu bar or Insert a datum plane. button from the Datum toolbar, the DATUM PLANE
submenu appears with the different options to create datum planes. Similarly, separate buttons
for creating datum axis, datum curve, datum point, datum coordinate system, and so on are
available in the Datum toolbar.

Figure 4-7 shows the different options available in the DATUM PLANE
submenu to create datum planes. Some of the options are standalone
and some require more than one constraint to define a datum plane,
that is, they are applied in pairs. The standalone options are constraints
that are sufficient by themselves to constrain a datum plane definition.

Through Option
The Through option is used to create a datum plane through any
specified axis, edge, curve, point/vertex, plane, cylinder, or coordinate
system. This option can be used in combination with other different
sub-options that are available in the DATUM PLANE submenu.
However, the combinations of options that you can use as standalone
are Through > AxisEdgeCurv, Through > Plane, and Through >
Cylinder. Figure 4-8 shows the datum plane constraint combinations
using the Through option. Datum planes can be created using any of
the combinations shown in the figure. The possible combinations of
datum plane creation are referred to as Yes and the combinations that
are not possible are referred to as No in the figure.

While reading the table shown in Figure 4-8, first preference is given
to the text written in first column and then the text in the first row
should be read. For example, if you want to make a datum plane that is passing through a
cylinder and normal to a plane then look for Through in the first column and then for Cylinder
in second column. Now, look for Normal in the first row and for Plane in the second row. After
finding both the combination trace them in the respective column and row till they intersect.
You will find Yes. This suggests that the creation of a datum plane that passes through a
cylinder and is normal to a plane is possible. While reading the table shown in Figure 4-8,
remember that the constraints that are not standalone have to be applied in pairs. When the
constraint applied is sufficient to constrain a datum plane, the message, Datum Plane is fully
constrained. Select "Done", "Quit" or "Restart" is displayed in the Message Area.

Figure 4-9 shows that the cylindrical surface and the default datum planes are used to create a
datum plane at an angle to the selected default datum plane and passing through the center
of the cylindrical surface as shown in Figure 4-10.

Figure 4-7  DATUM
PLANE submenu

Tip: Generally, for the base feature creation, the three default datum planes are used
and as the part becomes complex or in other words as the number of features increases,
the need for additional datum planes arises.



4-6      Pro/ENGINEER for Designers
©

 C
A

D
C

IM
 T

©
 C

A
D

C
IM

 T
©

 C
A

D
C

IM
 T

©
 C

A
D

C
IM

 T
©

 C
A

D
C

IM
 T

e
ch

n
o

lo
g

ie
s,

 U
S

A
e

ch
n
o

lo
g

ie
s,

 U
S

A
e

ch
n
o

lo
g

ie
s,

 U
S

A
e

ch
n
o

lo
g

ie
s,

 U
S

A
e

ch
n
o

lo
g

ie
s,

 U
S

A
. 

F
. 

F
. 

F
. 

F
. 

F o
r 

o
nl

in
e

 t
ra

in
in

g
, 

co
nt

a
ct

 s
a

le
s@

ca
d

ci
m

.c
o

m
o

r 
o

nl
in

e
 t

ra
in

in
g

, 
co

nt
a

ct
 s

a
le

s@
ca

d
ci

m
.c

o
m

o
r 

o
nl

in
e

 t
ra

in
in

g
, 

co
nt

a
ct

 s
a

le
s@

ca
d

ci
m

.c
o

m
o

r 
o

nl
in

e
 t

ra
in

in
g

, 
co

nt
a

ct
 s

a
le

s@
ca

d
ci

m
.c

o
m

o
r 

o
nl

in
e

 t
ra

in
in

g
, 

co
nt

a
ct

 s
a

le
s@

ca
d

ci
m

.c
o

m

Figure 4-10  Resultant datum plane passing
through the center of a cylinder and at an angle

Figure 4-9  Selecting a cylindrical surface and a
default datum plane to create a datum plane

Figure 4-8  Datum plane constraint combinations using the Through option

Normal Option
The Normal option is used to create a datum plane normal to any specified axis, edge, curve,
or plane. This option is used in combination with other different sub-options that are available
in the DATUM PLANE submenu. The Normal option in combination with any of the
sub-options cannot be used as standalone. Figure 4-11 shows the datum plane constraint
combinations using the Normal option. The possible combinations of datum plane creation
are referred to as Yes and the combinations that are not possible are referred to as No.
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Figure 4-12 shows a planar surface and a cylindrical surface. The planar surface is selected as
the normal surface and the cylindrical surface is selected to be tangent to the datum plane.
The datum plane that is created is shown Figure 4-13.

Parallel Option
The Parallel option is used to create a datum plane parallel to any specified datum plane or
planar surface. This option is used in combination with other different sub-options in the
DATUM PLANE submenu. The Parallel option in combination with the Plane sub-option
cannot be used as standalone. Figure 4-14 shows different datum plane constraint combinations
using the Parallel option. The possible combinations of datum plane creation are referred to
as Yes and the combinations that are not possible are referred to as No in the figure.

Figure 4-11  Datum plane constraints combinations using the Normal option

Figure 4-13  Resultant datum planeFigure 4-12  Selecting a planar surface and a
cylindrical surface to create a datum plane
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Figure 4-16  Resultant datum planeFigure 4-15  Selecting a datum plane and an axis
to create a datum plane

Figure 4-15 shows the selection of a default datum plane and an axis to create a datum plane.
The resultant datum plane is parallel to the selected datum plane and passes through the axis
as shown in Figure 4-16.

Offset Option
The Offset option is used to create a datum plane at an offset distance to any specified plane
or coordinate system. This option is used in combination with other different sub-options
available in this submenu. However, the Offset > Plane option can be used as standalone.
This option is used to create a datum plane at some specified parameters. The parameters
that are required to specify the offset distance are discussed below:

Thru Point
The Thru Point option is used to specify a point on the model through which the datum
plane will pass.

Figure 4-14  Datum plane constraint combinations using the Parallel option
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Figure 4-17  Datum plane constraint combinations using the Offset option

Enter Value
The Enter Value option is used to specify an offset distance and in the case of angular
planes you have to specify the angle. These values are entered in the Message Input
Window that appears. An arrow appears on the model that shows the positive direction of
the offset distance or angle.

Figure 4-17 shows different datum plane constraint combinations using the Offset option.
The possible combinations of datum plane creation are referred to as Yes and the combinations
that are not possible are referred to as No in the figure.

Figure 4-18 shows the selection of a default datum plane and a vertex to define an offset
datum plane. The resultant datum plane is at an offset to the selected datum plane and passes
through the vertex as shown in Figure 4-19.

Figure 4-19  Resultant datum planeFigure 4-18  Selecting a datum plane and an axis
to create a datum plane
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Angle Option
The Angle option is used to create datum planes through any specified plane. This option is
used with other sub-options in the DATUM PLANE submenu to create different types of
datum planes. The Angle > Plane combination of options cannot be used as standalone. The
value for angle is entered in the Message Input Window that appears when all the constraints
are defined. Figure 4-20 shows the datum plane constraint combinations using the Angle
option. The possible combinations of datum plane creation are referred to as Yes and the
combinations that are not possible are referred to as No in the figure.

Figure 4-21 shows the selection of a planar surface, an edge and a vertex to create a datum
plane that is shown in Figure 4-22. The datum plane created is at an angle to the selected
planar surface and passes through the selected edge and vertex. The vertex is selected by
choosing the Thru Point option from the OFFSET submenu that is displayed when you choose
Done from the DATUM PLANE submenu.

Figure 4-20  Datum plane constraint combinations using the Angle option

Figure 4-22  Resultant datum planeFigure 4-21  Selecting a datum plane and an axis
to create a datum plane
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The Tangent option creates datum planes tangent to cylindrical features. This option is also
used with the other options in the DATUM PLANE submenu to create different types of
datum planes. Figure 4-23 shows the datum plane constraint combinations using the Tangent
option. The possible combinations of datum plane creation are referred to as Yes and the
combinations that are not possible are referred to as No in the figure.

BlendSection Option
The BlendSection option is used to create the datum planes by selecting the features. This
option works as standalone.

Datum Planes Created “On The Fly”
The term “On the Fly” refers to the creation of a datum plane when the system prompts you
to select or create a plane. At this step, the SETUP PLANE submenu is displayed. When you
choose the Make Datum option from this submenu, the DATUM PLANE submenu is displayed.
You can select the options from this submenu to create a datum plane. When you create a
datum plane using the Make Datum option, the datum plane is neither visible on the graphics
screen nor is displayed on the Model Tree once the feature is completed. This option of
creating datum planes is referred to as “creating datum planes on the fly”. This option is
provided by Pro/ENGINEER in order to avoid cluttering of datum planes in a complex model.

Datum Axes
Datum axis is an imaginary axis that is created in Pro/ENGINEER to help you in creating a
model. Datum axes can be created manually. They are also created automatically when any
cylindrical feature is created. The display of a datum axis can be turned on or off by using the
Datum axes on/off button from the Datum Display toolbar. The uses of datum axes are discussed
next:

1. Datum axes act as reference for feature creation.

Figure 4-23  Datum plane constraints combination using the Tangent option
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2. They are used in creating a datum plane along with different constraint combinations.

3. They are used in placing features co-axially.

4. They are also used to create radial patterns. You will learn to create patterns in Chapter 6.

Datum axes are named by default in Pro/ENGINEER. The default
name of a datum axis is A_(Number), where Number represents
the number of that datum axis. However, the default name of the
datum axes can be changed in the same way as that of the datum
planes.

When you choose Insert > Datum > Axis from the menu bar or
Insert a datum axis. button from the Datum toolbar, the DATUM
AXIS submenu appears with different options to create datum axes
as shown in Figure 4-24. The options in the DATUM AXIS submenu
are explained next. These options are explained using an extruded
model.

Thru Edge Option
The Thru Edge option is used to create a datum axis through any selected edge. The selected
edge must be straight for the creation of a datum axis. In Figure 4-25, A_1 is the datum axis
created using this option.

Note
Unlike the datum planes constraint options, all the datum axes constraint options are standalone.

While creating a datum axis, some options in the DATUM AXIS submenu require datum points
to be selected while constraining the datum axis. Therefore, while using options like Pnt Norm
Pln and Pnt on Surf from the DATUM AXIS submenu, you need to create datum points.

Normal Pln Option
The Normal Pln option is used to create a datum axis normal to any selected planar surface or
datum plane. When you select a planar surface or a datum plane, you are prompted to select
its placement location on the datum plane. After you select its placement location, you are
prompted to select two edges, axes, datums, or planar surfaces to specify the linear dimension
for the placement of the datum axis. When you select the first edge for the placement dimensions
of the axis, the Message Input Window is displayed. A default value is displayed in the window.
You can accept the default dimension or change it to the required value. Similarly, select the
second edge for dimensioning and enter the dimension value in the window that appears. In
Figure 4-26, A_2 is the datum axis created using this option.

Pnt Norm Pln Option
The Pnt Norm Pln option creates a datum axis passing through a datum point and normal to
any planar surface or datum plane. When you choose this option to create a datum axis, you

Figure 4-24  DATUM
AXIS submenu
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are prompted to select a datum plane or a planar surface. Select a plane to which the datum
axis will be normal. Now, you are prompted to select a datum point. Select a datum point to
create an axis passing through the datum point. In Figure 4-27, A_3 is the datum axis created
using this  option.

Thru Cyl Option
The Thru Cyl option is used to create a datum axis through a cylindrical or a round surface.
When you choose this option from the DATUM AXIS submenu, you are prompted to select a
revolved surface. The axis is automatically created around the revolved surface through an
imaginary axis. In Figure 4-28, A_4 is the datum axis that is created using this option.

Figure 4-26  Datum axis created normal to
the plane

Figure 4-25  Datum axis created along the edge

Figure 4-28  Datum axis passing through a
cylinder

Figure 4-27  Datum axis passing through the
datum point and normal to the plane
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Two Planes Option
The Two Planes option is used to create a datum axis passing through the edge where two
planes meet or at the intersection edge of two planar surfaces or datum planes. When you
choose this option, you are prompted to select a planar surface or a datum plane. In Figure 4-29,
A_5 is the datum axis that is created using this option.

Two Pnt/Vtx Option
The Two Pnt/Vtx option is used to create a datum axis between two datum points or edge
vertices. When you choose this option, you are prompted to select datum points or edge
vertices. The datum axis is created along the two selected datum points or edge vertices. In
Figure 4-30, A_6 is the datum axis that is created using this option.

Pnt on Surf Option
The Pnt on Surf option is used to create a datum axis passing through any selected datum
point on a surface. When you choose this option, you are prompted to select a placement
point. The datum axis is created normal to the surface on which the datum point is selected
and passes through the datum point. In Figure 4-31, A_7 is the datum axis that is created
using this option.

Tan Curve Option
The Tan Curve option creates a datum axis tangent to a curve and passing through one of its
vertex. When you choose this option, you are prompted to select an edge or a curve. After you
select a curve or an edge you are prompted to select one vertex of the edge. The datum axis is
created tangent to the curve and passes through its selected vertex. In Figure 4-32, A_8 is the
datum axis that is created using this option.

Datum Points
Datum points are imaginary points created in Pro/ENGINEER to aid in creating models,
drawings, analyzing models, and so on. The uses of datum points are discussed next.

Figure 4-30  Datum axis created between the
two selected vertices

Figure 4-29  Datum axis created on the edge
where the two selected planes meet
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1. To create datum planes and axes.

2. To associate note in the drawings and attach datum targets.

3. To create coordinate system.

4. To specify point loads for mesh generation.

5. To create pipe features.

The default name associated with a datum point by Pro/ENGINEER is PTN(Number) where
Number indicates the number of datum points created in a particular object. However, you
can change the default name associated with the datum points.

When you choose Insert > Datum > Point from the menu bar or
Insert a datum point. button from the Datum toolbar, the DATUM
POINT submenu appears with different options to create datum
points as shown in Figure 4-33. The options in the DATUM POINT
submenu are explained next.

On Surface Option
The On Surface option is used to create datum points on a planar
surface. When you choose this option from the DATUM POINT
submenu, you are prompted to select the desired location for the
placement of the datum point. When you select a planar surface or
a datum plane to place the datum point, a red colored point is
displayed at the selected point on the surface. Confirm the selection
using the middle mouse button. Next, you are prompted to select

Figure 4-32  Datum axis created tangent to the
selected curve

Figure 4-31  Datum axis passing through the
datum point

Figure 4-33  DATUM
POINT submenu
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two planes or edges to specify the linear dimensions for the placement of the datum point.
After you select the two planes or edges for the placement dimension of the point, the Message
Input Window is displayed with the first selection highlighted and you are prompted to specify
the distance from the highlighted references. A default value is displayed in the window. You
can accept the default value or change it to the required value and then press ENTER. The
second selection will be highlighted and you will be prompted to enter the distance from the
highlighted references. Enter the dimension value in the window that appears. Press the middle
mouse button, the datum point is created.

Offset Surf Option
The Offset Surf option creates datum points at an offset distance from a specified planar
surface or a datum plane in a specified direction. When you choose this option to create a
datum point, you are prompted to select the desired location for the datum point. Select a
planar surface or a datum plane from where the offset distance for the placement of the datum
point will be measured. Use the middle mouse button to confirm the selection. You will be
prompted to select the planes or the edges for dimensioning the point. Select two planes or
edges for dimensioning and enter the distances from the highlighted references. You will now
be prompted to enter the offset distance in the specified direction shown by the arrow. Enter
the value in the Message Input Window that appears and press ENTER. Press the middle
mouse button and the datum point is created. If you enter a negative value in the Message
Input Window then the datum point will be created in the direction opposite to that shown by
the arrow.

Curve X Srf Option
The Curve X Srf option is used to create a datum point at the intersection of a curve and a
surface. When you choose this option to create a datum point, you will be prompted to select
a curve, edge, or axis. After selecting the curve, edge, or axis, you are prompted to select
surfaces that intersect the edge. Select a surface or a datum plane. Press the middle mouse
button and the datum point is created.

On Vertex Option
The On Vertex option is used to create a datum point on the vertex of a part, edge, surface
feature edge, or a datum curve. When you choose this option, you are prompted to select
vertices where you want to place the datum points. Select the vertices and press the middle
mouse button to create the datum points.

Offset Csys Option
The Offset Csys option is used to create an array of datum points at an offset distance from
a coordinate system. You can change the array of the points by redefining the array.

When you choose this option, you are prompted to select a coordinate system. After selecting
a coordinate system, the SET CSYS TYP (Set Coordinate System Type) submenu is displayed
and you are prompted to select the type of coordinate system; Cartesian, Cylindrical, or
Spherical. After selecting the type of coordinate system, the POINT ARRAY submenu is
displayed and you are prompted to enter the points. Choose the Enter Points option from the
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to enter a parameter, this parameter will define the location of the datum point and depends
on the type of coordinate system selected from the SET CSYS TYP submenu.

Three Srfs Option
The Three Srfs option is used to create datum points at the intersection of three surfaces.
When you choose this option, you are prompted to select the first surface. After selecting the
first surface, you are prompted to select the second surface. Select the second surface. You will
then be prompted to select the third surface. Select the third surface on the model. The datum
point is placed at the intersection of the three surfaces selected and appears in green color.
Confirm the selection by using the middle mouse button. Using this option, you can also
select datum planes to create datum points.

At Center Option
The At Center option creates a datum point at the center of an arc or a circle. When you
choose this option, you are prompted to select an edge or a curve, at the center of which the
datum point will be created. Confirm the selection by using the middle mouse button. The
datum point will be created.

On Curve Option
The On Curve option is used to create a datum point on an edge or a curve. When you choose
this option, the DTM PNT MODE submenu and the PNT DIM MODE submenu are displayed
and you are prompted to specify the dimension type for the datum point. Choose the options
from the PNT DIM MODE submenu to select the type of dimensioning.

Crv X Crv Option
The Crv X Crv option is used to create a datum point on a datum curve at the point that is at
the minimum distance from another datum curve.

When you choose this option, you are prompted to select a curve where the point should be
placed. After selecting the datum curve, you are prompted to select a second curve close to the
placement of the point. The datum point will be created on the first curve at a point that is
closest to the second curve.

Note
Datum curves will be discussed in Chapter 7.

Offset Point Option
The Offset Point option is used to create datum points at an offset
distance from a point or a vertex. When you choose the Offset Point
option from the DATUM POINT submenu, the OFFSET DIR
submenu is displayed as shown in Figure 4-34. The options in this
submenu are discussed next.

Figure 4-34  OFFSET
DIR submenu
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Figure 4-35  FIELD
PNT submenu

Entity/Edge
When you choose the Entity/Edge option, you are prompted to select an axis, a straight
edge, or a straight curve. After you select any one of the above mentioned entities, you are
prompted to select vertices, points, or coordinate systems to offset from. After selecting a
vertex, a point, or a coordinate system, press the middle mouse button. The Message
Input Window is displayed and you are prompted to specify the offset distance in the
direction shown by the red arrow. The datum point will be placed at the specified distance
from the selected entity. In case you want to create more then one datum points, you need
to select more then one vertices, points, or coordinate systems to place the datum points.
The system will prompt you to enter the offset distance from each point selected. After
specifying the offset distance all the points, press the middle mouse button to create the
datum points.

The procedure to create datum points using the other options in the OFFSET DIR submenu
is the same as discussed in the Entity/Edge option.

Plane Norm
The Plane Norm option places one or more datum points normal to the plane selected
and at the specified offset distance.

2 Points
The 2 Points option creates one or more datum points in a direction along a straight line
that is defined by the two selected points.

Coord Sys
The Coord Sys option creates one or more datum points aligned with the three directions
of the selected coordinate system.

Field Point
When you choose the Field Point option, the FIELD PNT submenu is
displayed as shown in Figure 4-35. The options in this submenu are
discussed next.

Any
The Any option is used to create a datum point anywhere on the
model. You just need to use the left mouse button to place a datum
point.

On Curve/Edge
The Curve/Edge option is used to create a datum point on any edge or curve of the
model.

On Surface
The On Surface option creates a datum point on the selected surface.
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The On Quilt option creates a datum point on a quilt.

Sketch
The Sketch option allows you to sketch a datum point. When you choose this option, you are
prompted to select a sketching plane. After selecting the sketching plane and the horizontal
and vertical references for sketching, the system takes you to the sketcher environment. Using
the sketcher options, draw the datum point and regenerate the sketch. The datum point is
created where it is placed in the sketch using dimensions.

CREATING CUTS
The Cut is a material removal process and this option is available only when at least a base
feature exists on the graphics screen. The Cut option can be invoked from the menu bar or
from the Menu Manager. Figure 4-36 shows the method of invoking the CUT option from the
menu bar. In the cascading menu, the types of cut that can be created in Pro/ENGINEER are
given. The procedure to create a cut on an existing feature is similar to that of adding material
or protrusion. The method to invoke the Cut option from the Menu Manager is, PART >
Feature > Create > Solid > Cut.

Figure 4-36  Invoking the Cut option from the menu bar
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Tip: In the model shown in Figure 4-38, the sketching plane selected for creation of
the extruded cut is not a datum plane but the planar surface of the base feature. You
can also create a datum plane on the surface of an existing feature and select it as the
sketching plane. But it is not recommended to create a datum plane in cases where a
planar surface of the feature can be used as a sketching plane.

Extrude Cut
The Extrude Cut is used to create an extruded feature by removing material from an existing
feature. The material that is removed is defined by the sketch you draw.

After drawing the sketch for the cut feature, you are prompted to specify the direction of
material removal with respect to the sketch. For example, the red arrow in Figure 4-37 shows
the direction of material removal. If the direction shown by the arrow is accepted then the cut
feature will be created as shown in Figure 4-38.

However, if you choose Flip from the DIRECTION menu, the arrow points in the direction
shown in Figure 4-39. All the material on the plane selected for sketching will be removed
leaving the extruded cut feature as shown in Figure 4-40.

Note
A straight hole can also be created by drawing its cross-section, that is, a circle, and then creating
an extrude cut. But, Pro/ENGINEER provides predefined placement for a hole feature that can
be more desirable than dimensioning the cross-section of a cut feature. Straight holes do not
require a sketch if you use the HOLE dialog box. The HOLE dialog box is discussed in Chapter 5.

Revolve Cut
The Revolve Cut is used to create a revolved feature by removing material from an existing
feature. The material that is removed is defined by the sketch you draw. Remember that the
centre line is necessary in the revolve features. Figure 4-41 shows the section drawn to be
revolved. The front surface of the second extruded feature is selected as the sketching plane.

Figure 4-38  Cut feature created on the selected
plane

Figure 4-37  Sketch for the extruded cut and arrow
showing the direction of material removal
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Figure 4-42 shows the revolve cut created on the selected surface.

Note
The Sweep Cut is explained in Chapter 7.

TUTORIALS

In this tutorial you will create the model shown in Figure 4-43. The front view and the
right-side view with dimensions of the solid model is shown in Figure 4-44.

   (Expected time: 25 min)

The following steps outline the procedure for creating this model:

Figure 4-40  Cut feature created in the direction
shown in the adjacent figure

Figure 4-39  Arrow showing the direction of
material removal

Figure 4-42  Revolve cut createdFigure 4-41  The section for revolve cut

Tutorial 1
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Figure 4-44  Front and side views of the model

a. First examine the model and then determine the number of features in it, see Figure 4-43.
The model is composed of four features: two at the top, one at the bottom, and one hole
on the right surface. Also, from the model it is evident that the two features at the top of
the model can be created on the same plane.

b. Select the sketching plane for the base feature, draw the sketch using the sketching tools,
apply the dimensions and constraints, and then extrude the sketch to the given distance,
see Figure 4-46.

Figure 4-43  Model for Tutorial 1
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mc. Select the sketching plane for the feature that is at the bottom of the base feature. This

feature will be sketched on the same plane that was used by the base feature. Draw the
sketch using the sketching tools, apply the dimensions and constraints, and then extrude
the sketch to the given distance, see Figure 4-50.

d. The third feature that is at the bottom of the second feature will be created on a datum
plane that is at an offset distance of 2 from the front planar surface of the second feature.
Draw the sketch, apply the dimensions and constraints, and then extrude it to the given
distance, see Figure 4-56.

e. Similarly, select a sketching plane for the cut feature. The cut has a circular section. Draw
the sketch for this feature and create the cut feature as shown in Figure 4-60.

After understanding the procedure for creating the model, you are now ready to create it.
When Pro/ENGINEER session is started, the first task is to set the working directory. Since
this is the first tutorial of this chapter, you need to create a folder named c04, if it does not
exist. Choose the New Directory button in the Select Working Directory dialog box and
create a directory named c04 at C:\ProE.

Creating New Object File
1. Open a new part file and name it as c04tut1. The three default datum planes are displayed

on the graphics screen. The Model Tree also appears on the left of the graphics screen.
Exit the Model Tree by choosing the Model Tree on/off button from the Model Display
toolbar.

Selecting the Sketching Plane for the Base Feature
To create the sketch for the base feature, you need to first select the sketching plane for the
base feature. In this model, you need to draw the base feature on the FRONT datum plane
because from the isometric view of this model, it is evident that the direction of extrusion for
this feature is perpendicular to the FRONT datum plane.

Note
The model can be created by selecting any plane as the sketching plane for the base feature. But
when the base feature is created, the orientation of the base feature will not be proper. Hence, the
final model will be oriented wrongly. You will have to be careful while defining the sketching
plane for the base feature. The desired orientation of the model is shown in Figure 4-43.

1. Invoke the Extrude option from the menu bar by selecting Insert > Protrusion > Extrude.
The ATTRIBUTES menu is displayed on the screen.

2. The One Side option in the ATTRIBUTES menu is selected by default. Choose Done.

3. Select the FRONT datum plane as the sketching plane.

A red arrow is displayed on the FRONT datum plane pointing in the direction of feature
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Tip: It is recommended to use the Modify the values of dimensions, geometry of
splines, or text entities. button to modify the weak dimensions. In the Modify
Dimensions dialog box that appears, clear the Regenerate check box and then
modify the dimensions using the thumbwheel or the dimension edit box. This way the
sketch will not regenerate as you edit dimensions.

Figure 4-45  Sketch for the base feature with
dimensions and constraints

creation and you are prompted to specify the direction of feature creation.

4. Choose Okay from the DIRECTION submenu. The SKET VIEW submenu is displayed.

5. Select Top from this menu and select the TOP datum plane from the graphics screen.

The TOP datum plane is selected in order to orient the sketching plane. As you select the
TOP datum plane, the system takes you to the sketcher environment.

Specifying References
In the sketcher environment, the References dialog box is displayed at the top right corner of
the screen. The status displayed in the Reference status area is Fully Placed. Close the
References dialog box by choosing the Close button from the dialog box.

Creating and Dimensioning the Sketch for the Base Feature
The base feature can be created by drawing the sketch and then extruding it to the given
distance.

1. Draw the section sketch using various sketcher tools and add the required constraints and
dimensions shown in Figure 4-45. Since the Intent Manager is on by default, the sketch is
dimensioned automatically and some weak dimensions are assigned to it.

2. Modify the dimension values to the values shown in Figure 4-45.

3. After the sketch is completed,
choose the Continue with the
current section. button. The
SPEC TO menu is displayed.

4. Choose the Default option from the
Saved view list button of the View
toolbar.

The default view is displayed. This gives
you a better view of the sketch in the 3D
space. The red colored arrow is also
displayed on the model, indicating the
direction of extrusion.
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m5. The Blind option in the SPEC TO menu is selected by default. Choose Done.

The Message Input Window is displayed with a default value in it.

6. Enter a value of 8 in the Message Input Window and press ENTER.

7. Choose the Preview button from the PROTRUSION dialog box and then choose OK to
complete the feature and to exit the PROTRUSION dialog box.

The base feature is completed and is shown in Figure 4-46. You can use CTRL+middle
mouse button to spin the model to view it from different directions.

Note
When you choose the Default option from the Saved view list button, the orientation of the
model is trimetric and not isometric. If you want the isometric view of the model to be displayed
whenever you choose the Default option then you have to use the Environment dialog box.
The Environment dialog box is displayed when you choose the Environment option from the
Utilities menu in the menu bar. From the dialog box in the Default Orient drop-down list,
choose the Isometric option. Now, the default orientation will be set to isometric.

Selecting the Sketching Plane for the Second Feature
The second feature is an extrude feature and will be drawn on the previous plane that was
used to draw the base feature.

1. Invoke the Extrude option by selecting Insert > Protrusion > Extrude from the menu
bar. The ATTRIBUTES menu is displayed.

2. The One Side option in the ATTRIBUTES menu is selected by default, choose Done.

You will be prompted to select the sketching plane.

3. Choose the Use Prev option from the SETUP SK PLN menu. The red arrow is displayed
on the graphics screen as shown in Figure 4-47.

When you choose the Use Prev option, the system selects the previous sketching plane
that was used to create the base feature. This option is selected because the base feature
and the second feature are on the same plane but have different depths of extrusion. If
they had same depth of extrusion, you could have drawn them on the same plane as a
single feature.

Tip: It is recommended to check the orientation of the base feature of a model when it
is completed. To check whether the plane you specified for sketching was correct or
not, choose the Saved view list button from the View toolbar. Choose the FRONT
option from the drop-down list; the base feature will reorient on the graphic screen
such that you can view the front view of the base feature, similar to that shown in
Figure 4-44.
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Tip: You can use the Create an entity from an edge button from the Sketcher Tools
toolbar to use the edge of the base feature. The edge of the base feature is required to
complete the sketch for the second feature. Or else, draw an aligned line on the edge.

In Figure 4-47, the model is oriented in its default orientation. The model can be oriented
in its default position by choosing the Default option from the Saved view list button.

4. Choose Okay from the DIRECTION submenu.

The system takes you to the sketcher environment.

Drawing the Sketch for the Second Feature
The second feature has a rectangular section that will be extruded to a depth of 14. To improve
the clarity of the edges of the base feature choose the No Hidden button from the Model
Display toolbar before you start sketching the second feature.

1. Draw the sketch as shown in Figure 4-48.

Since the Intent Manager is on by default, therefore, the sketch is automatically
dimensioned and some weak dimensions are assigned to it. Add the required constraints
and modify the weak dimensions as shown in Figure 4-48.

2. Choose the Continue with the current section. button. The SPEC TO menu is
displayed. Choose the Shading button from the Model Display toolbar to view
the shaded model.

3. Use the CTRL+middle mouse button to orient the model as shown in Figure 4-49. This
orientation of the model gives you a better view of the sketch in the 3D space. The red
colored arrow is also displayed on the model, indicating the direction of extrusion.

Figure 4-47  Arrow showing the direction of
feature creation

Figure 4-46  Base feature of the model without
datums
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4. The Blind option in the SPEC TO menu is selected by default, choose Done. The Message
Input Window is displayed with a default value in it.

5. Enter a value of 14 in the Message Input Window and press ENTER.

The second extruded feature is completed
and it can now be previewed.

6. Choose the Preview button from the
PROTRUSION dialog box.

7. Choose the Saved view list button from
the View toolbar. From the drop-down list
choose the Default option.

8. Now, choose the OK button from the
PROTRUSION dialog box to confirm
the feature creation and exit the dialog
box. The model orients on the screen as
shown in Figure 4-50. You can also use
the CTRL+middle mouse button to spin
the model.

Creating a Datum Plane for the Third Feature
A datum plane is required to create the next feature. The datum plane will be at an offset
distance of 2 from the front planar surface of the second feature.

Figure 4-49  Arrow showing the direction of
feature depth

Figure 4-48  Sketch for the second feature

Figure 4-50  Second extruded feature with the base
feature
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1. Choose the Insert a datum plane. button from the Datum toolbar. The DATUM
PLANE submenu is displayed.

2. Choose the Offset option from the DATUM PLANE submenu. As you choose the Offset
option, the Plane and the Coord Sys options are highlighted and the system prompts you
to select either a plane or a coordinate system.

3. Using the left mouse button, select the front planar surface of the second feature highlighted
in Figure 4-51. The boundary of the selected front planar surface is highlighted red in
color.

The OFFSET submenu is displayed and you are prompted to select a location or enter a
value for the datum plane to pass through.

4. From the OFFSET submenu, choose the Enter Value option.

A green arrow is displayed on the selected planar surface and the Message Input Window is
displayed with a default value. You are prompted to enter an offset value in the direction
shown by the arrow. If you enter a positive value, the datum plane will be created in the
direction shown by the arrow and if you enter a negative value then the datum plane will be
created in the direction opposite to that shown by the arrow.

5. Enter a value of -2 in the Message Input Window and press ENTER. Choose Done from
the DATUM PLANE submenu.

The negative value is entered because the datum plane has to be created in the direction
opposite to that shown by the green arrow. The datum plane named DTM1 is created as
shown in Figure 4-52.

Note
Throughout the book at some instances the datum planes are shown by a mesh plane as evident
from Figure 4-52. This view of the datum plane is only for explanation. In Pro/ENGINEER,
when you create a datum plane, they do not appear in the form of mesh.

Creating the Third Feature on DTM1
The datum plane DTM1 is created and can be seen in the Model Tree as well as on the
graphics screen. The section sketch of the next feature that will be extruded has to be created
on the datum plane DTM1.

1. Invoke the Extrude option from the menu bar. The ATTRIBUTES menu is displayed.

2. The One Side option in the ATTRIBUTES menu is selected by default, choose Done.
The SETUP PLANE submenu is displayed.

3. Select DTM1 as the sketching plane for the third feature. A red arrow is displayed on the
selected datum plane.
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4. Choose Flip from the DIRECTION submenu. The arrow displayed on the model now
points in the direction as shown in Figure 4-53.

The red arrow shows the direction of feature creation.

5. Choose Okay from the DIRECTION submenu. The SKET VIEW submenu is displayed
and you are prompted to select a horizontal or vertical reference.

6. Select the Top option from the SKET VIEW submenu and choose the TOP default datum
plane. The system takes you to the sketcher environment. Choose the No Hidden button
from the Model Display toolbar.

7. Sketch the section for the third feature of the model and add constraints and dimensions
to the sketch as shown in Figure 4-54.

Figure 4-52  The highlighted datum planeFigure 4-51  Planar surface

Figure 4-54  Sketch with dimensions and
constraints of the third feature

Figure 4-53  Arrow on DTM1 showing the
direction of feature creation
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Figure 4-56  Model after creating the third featureFigure 4-55  Arrow showing the direction of
material addition

8. Choose the Continue with current section. button.

The SPEC TO menu is displayed and you are prompted to specify the depth of extrusion.
The red color arrow is also displayed on the model. Use the CTRL+middle mouse button
to orient the model as shown in Figure 4-55. This orientation gives a better view of the
model.

9. The Blind option in the SPEC TO menu is selected by default, choose Done.

The Message Input Window is displayed with a default value in it.

10. Enter a value of 10 in the Message Input Window and press ENTER.

The third extruded feature is completed and it can now be previewed.

11. Choose the Preview button from the PROTRUSION dialog box. To view the shaded
image of the model, choose the Shading button from the Model Display toolbar.

12. Choose the OK button from the PROTRUSION dialog box to confirm the feature creation
and to exit the dialog box.

The default view that is displayed when you choose the Default option from the Saved
view list button is shown in Figure 4-56.

Selecting the Sketching Plane for the Cut Feature
A through cut will be created on the outer right surface of the third feature. The circular
section for the cut will be sketched and using the Cut option from the SOLID menu, the
circular cut will be created. The sketching plane will be the surface of the third feature that is
shown in Figure 4-57.
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The circular cut feature can also be created using the HOLE dialog box that will be discussed in
Chapter 5.

1. Choose Insert > Cut > Extrude from the menu bar or choose PART > Feature > Create
> Solid > Cut > Extrude > Solid > Done from the Menu Manager. The ATTRIBUTES
menu is displayed.

2. Choose One Side > Done from the ATTRIBUTES menu.

You will be prompted to select or create a sketching plane.

3. Select the planar surface shown in Figure 4-57 and specify the direction of feature creation.

The SKET VIEW submenu is displayed and you are prompted to select a horizontal or
vertical reference.

4. Using the left mouse button select the Top option from the SKET VIEW submenu and
select the TOP default datum plane.

The system takes you to the sketcher environment.

Sketching the Cut Feature
1. Turn the model display to No Hidden. Draw the sketch of the cut feature and add

dimensions to it as shown in Figure 4-58. The hole dimension shown in Figure 4-58 appears
as a radial dimension but it is a diameter dimension.

2. Choose the Continue with current section. button.

You will be prompted to select the direction of material removal. The direction is shown

Figure 4-58  Sketch and dimensions for holeFigure 4-57  Sketching plane for hole feature
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Figure 4-60  Completed model for Tutorial 1 Figure 4-61  Model Tree for Tutorial 1

by the red arrow. The arrow should point
as shown in Figure 4-59.

3. Choose Okay from the DIRECTION
menu.

The SPEC TO menu is displayed and
you are prompted to specify the depth
of extrusion.

4. Select the Thru All option from the
SPEC TO menu and then choose Done.

The cut feature is completed and it will
now be previewed.

5. Choose the Preview button from the CUT dialog box and then choose OK. Turn the
model display to shaded by choosing the Shading button from the Model Display toolbar.

The default view, when you choose the Default option from the Saved view list button
from the View toolbar, is shown in Figure 4-60.

Saving the Model
1. Choose the Save the active object button from the File toolbar and save the model.

The order of feature creation can be seen from the Model Tree shown in Figure 4-61.

Note
The feature id numbers that are suffixed to the feature name in the Model Tree may be different
when you create the features.

Figure 4-59  Arrow showing the direction of material
removal
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In this tutorial you will create the model shown in Figure 4-62. This figure also shows the front
view, the top view, and the right-side view of the solid model.     (Expected time: 45 min)

The following steps outline the procedure for creating this model:

a. First, examine the model and then determine the number of features in it, see Figure 4-62.
The model is composed of four features: one at the bottom (base feature), one on the left,
and two at the back. Also, from the model it is evident that the two features on the back
face of the model can be created on the same plane.

b. Select the sketch plane for the base feature, draw the sketch using the sketching tools,
apply the dimensions and constraints, and then extrude the sketch to the given depth, see
Figure 4-64.

c. Select the sketch plane for the feature on the left face of the base feature, draw the sketch
using the sketching tools, apply dimensions and constraints, and then extrude the sketch
to the given depth, see Figure 4-69.

Tutorial 2

Figure 4-62  Top, front, right-side, and isometric views of the model



4-34      Pro/ENGINEER for Designers
©

 C
A

D
C

IM
 T

©
 C

A
D

C
IM

 T
©

 C
A

D
C

IM
 T

©
 C

A
D

C
IM

 T
©

 C
A

D
C

IM
 T

e
ch

n
o

lo
g

ie
s,

 U
S

A
e

ch
n
o

lo
g

ie
s,

 U
S

A
e

ch
n
o

lo
g

ie
s,

 U
S

A
e

ch
n
o

lo
g

ie
s,

 U
S

A
e

ch
n
o

lo
g

ie
s,

 U
S

A
. 

F
. 

F
. 

F
. 

F
. 

F o
r 

o
nl

in
e

 t
ra

in
in

g
, 

co
nt

a
ct

 s
a

le
s@

ca
d

ci
m

.c
o

m
o

r 
o

nl
in

e
 t

ra
in

in
g

, 
co

nt
a

ct
 s

a
le

s@
ca

d
ci

m
.c

o
m

o
r 

o
nl

in
e

 t
ra

in
in

g
, 

co
nt

a
ct

 s
a

le
s@

ca
d

ci
m

.c
o

m
o

r 
o

nl
in

e
 t

ra
in

in
g

, 
co

nt
a

ct
 s

a
le

s@
ca

d
ci

m
.c

o
m

o
r 

o
nl

in
e

 t
ra

in
in

g
, 

co
nt

a
ct

 s
a

le
s@

ca
d

ci
m

.c
o

m

d. From the model it is evident that the third and fourth features are created on the same
plane, but their depths of extrusion are different and hence they will be created as two
separate extruded features. See Figure 4-74 and Figure 4-78.

After understanding the procedure for creating the model, you are now ready to create it.
The working directory is already selected in Tutorial 1 and therefore you do not need to
select it again. However, if you want to select the working directory, choose File > Set
Working Directory and then select c04 in the Select Working Directory dialog box.

Creating New Object File
1. Open a new part file and name it as c04tut2. The three default datum planes are displayed

on the graphics screen if the Datum planes on/off button is turned on. The Model Tree is
not displayed on the graphics screen as its display was turned off in the previous tutorial.

Selecting the Sketching Plane for the Base Feature
To create the sketch for the base feature, you need to first select the sketching plane for the
base feature. In this model, you need to draw the base feature on the TOP datum plane
because the direction of extrusion of the base feature is perpendicular to the TOP datum
plane.

1. Invoke the Extrude option from the menu bar by choosing Insert > Protrusion > Extrude.
The ATTRIBUTES menu is displayed.

2. The One Side option in the ATTRIBUTES menu is selected by default. Choose Done.
The One Side option will extrude the sketch to one side of the sketching plane. You are
now prompted to select or create a sketching plane.

3. Select the TOP datum plane as the sketching plane.

A red arrow is displayed on the TOP datum plane pointing in the direction of feature
creation and you are prompted to specify the direction of feature creation.

4. Choose Okay from the DIRECTION submenu. The SKET VIEW submenu is displayed.

5. Choose the Right option from this submenu and select the RIGHT datum plane from the
graphics screen.

The RIGHT datum plane is selected in order to orient the model. As you choose the
RIGHT datum plane, the system takes you to the sketcher environment.

Specifying References
In the sketcher environment, the References dialog box is displayed at the top right corner of
the screen. The status displayed in the Reference status area is Fully Placed. Exit the
References dialog box by choosing the Close button from the dialog box.
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The sketch for the base feature consists of a rectangular shape with a slot as shown in Figure 4-63.
When this sketch is extruded, it will create the base feature with the slot as shown in Figure 4-64.

1. Draw the section sketch using various sketcher tools and add the required constraints and
dimensions to it as shown in Figure 4-63.

Since the Intent Manager is on by default, the sketch is automatically dimensioned and
some weak dimensions are assigned to it. Modify these dimensions as shown in Figure 4-63.

2. Choose the Continue with the current section. button. The SPEC TO menu is
displayed and you are prompted to specify the depth of extrusion.

3. Choose the Default option from the Saved view list button of the View toolbar.

The default view is displayed. This gives you a better view of the sketch in the 3D space. A
red arrow is also displayed on the model, indicating the direction of extrusion.

4. The Blind option in the SPEC TO menu is selected by default. Choose Done.

The Message Input Window is displayed with a default value in it.

5. Enter a value of 16 in the Message Input Window and press ENTER.

6. Choose the Preview button from the PROTRUSION dialog box and then choose OK.

The base feature is completed and is shown in Figure 4-64. You can use the CTRL+middle
mouse button to spin the object to view it from different directions.

Figure 4-64  Base feature of the modelFigure 4-63  Sketch with dimensions and
constraints for the base feature
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Figure 4-66  Surface selected to be at the topFigure 4-65  Arrow showing the direction of
feature creation from  the sketching plane

Selecting the Sketching Plane for the Second Feature
The next feature is an extruded feature and will be created on the left planar surface of the
base feature. Therefore, you need to define the left face of the base feature as the sketching
plane and then draw the sketch.

1. Invoke the Extrude option by selecting Insert > Protrusion > Extrude from the menu
bar. The ATTRIBUTES menu is displayed.

2. The One Side option in the ATTRIBUTES menu is selected by default. Choose Done.
You will now be prompted to select or create a sketching plane.

3. Using the CTRL+middle mouse button, spin the model as shown in Figure 4-65.

4. Now, select the left planar surface of the base feature as the sketching plane.
A red arrow that points in the direction of feature creation is displayed on the planar
surface.

5. Use the Flip option to flip the red arrow to point in the direction of extrusion as shown in
Figure 4-65.

6. Choose Okay from the DIRECTION submenu. The SKET VIEW submenu is displayed.

7. Select Top from this menu and choose the top planar surface of the model shown in
Figure 4-66.

By selecting the top surface of the base feature, the model will be oriented in such a way
that the highlighted planar surface will be at the top while sketching. After you select the
surface, the system takes you to the sketcher environment.
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The sketch for the second feature consists of two lines and an arc. The bottom edge of the
sketch coincides with the top edge of the base feature. This sketch is extruded to a depth of 16.
Before drawing the sketch, turn the model display to No Hidden.

1. Close the References dialog box that is displayed on the top right corner of the screen.

2. Draw the sketch using various sketcher
tools as shown in Figure 4-67.

Since the Intent Manager is on by
default, the sketch is dimensioned
automatically and some weak dimensions
are assigned to it.

3. Apply the constraints and modify the
weak dimensions to the dimensions
shown in Figure 4-67.

4. After the sketch is complete, turn
the model display to Shading
and choose the Continue with
the current section. button.

The SPEC TO menu is displayed and you are prompted to specify the depth of extrusion.
Use the CTRL+middle mouse button to orient the model as shown in Figure 4-68. A red
arrow is also displayed on the model, indicating the direction of extrusion.

5. The Blind option in the SPEC TO menu is selected by default. Choose Done. The Message
Input Window is displayed with a default value in it.

6. Enter a value of 16 in the Message Input Window and press ENTER. The second feature
is completed and it can now be previewed.

7. Choose the Preview button from the PROTRUSION dialog box and then choose OK.

The second feature is completed and is shown in Figure 4-69. You can use the
CTRL+middle mouse button to spin the model to view it from different directions.

Selecting the Sketching Plane for the Third Feature
The third feature is an extruded feature and will be created on the back planar surface of the
base feature. Therefore, you need to define the back face of the base feature as the sketching
plane and then draw the sketch.

1. Invoke the Extrude option from the menu bar. The ATTRIBUTES menu is displayed.

Figure 4-67  Sketch with dimensions and constraints
for the second feature
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2. The One Side option in the ATTRIBUTES menu is selected by default. Choose Done.

The One Side option will extrude the sketch to one side of the sketching plane. You are
now prompted to select or create a sketching plane.

3. Using the CTRL+middle mouse button, spin the model and select the planar surface of
the base feature shown in Figure 4-70 as the sketching plane.

A red arrow is displayed on the planar surface and it points in the direction of feature
creation.

4. Use the Flip option to flip the red arrow in the direction of extrusion as shown in
Figure 4-70. The sketch will be extruded in the direction of the arrow.

5. Choose Okay from the DIRECTION submenu. The SKET VIEW submenu is displayed.

6. Select Top from this menu and choose the top planar surface shown in Figure 4-71.

The top planar surface of the base feature is selected to be at the top while drawing the
sketch. As you choose the planar surface from the base feature, the system takes you to the
sketcher environment.

Creating and Dimensioning the Sketch for the Third Feature
The sketch for the base feature consists of a rectangular section with a semicircular cut at the
top. When this section is extruded, a feature with a semicircular slot will be created.

1. Draw the section sketch using various sketcher tools as shown in Figure 4-72.

Figure 4-68  Arrow showing the direction of
material addition

Figure 4-69  Model with the second extruded
feature
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2. Since the Intent Manager is on by default, the sketch is dimensioned automatically and
some weak dimensions are assigned to it. Add the required constraints and modify the
weak dimensions to the dimensions shown in Figure 4-72.

3. Choose the Continue with the current section. button. The SPEC TO menu is
displayed and you are prompted to specify the depth of extrusion.

4. Use the CTRL+middle mouse button to orient the model as shown in Figure 4-73. This
orientation of the model gives a better view of the sketch in 3D space. A red arrow is also
displayed on the model, indicating the direction of extrusion.

5. The Blind option in the SPEC TO menu is selected by default. Choose Done.

Figure 4-71  Surface selected to be at the topFigure 4-70  Arrow showing the direction of
feature creation from the sketching plane

Figure 4-73  Arrow showing the direction of
material addition

Figure 4-72  Sketch with dimensions and
constraints
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Figure 4-75  Arrow showing the direction of feature
creation

Figure 4-74  Model with the second extruded
feature

The Message Input Window is displayed with a default value in it.

6. Enter a value of 42 in the Message Input Window and press ENTER. This feature is
completed and it can now be previewed.

7. Choose the Preview button from the PROTRUSION dialog box.

8. Now, choose the OK button from the PROTRUSION dialog box to confirm the feature
creation and to exit the dialog box. The default view that is displayed when you choose
the Default option from the Saved view list button is shown in Figure 4-74.

Selecting the Sketching Plane for the Last Feature
As mentioned earlier, this feature and the third feature are on the same plane. But the depth
of extrusion is different for both of them. This is the reason they are considered as separate
features. Therefore, for sketching this feature you can use the sketching plane that was used
for creating the third feature.

1. Invoke the Extrude option from the menu bar. The ATTRIBUTES menu is displayed.

2. The One Side option in the ATTRIBUTES menu is selected by default. Choose Done.
You are now prompted to select or create a sketching plane.

3. Choose the Use Prev option from the SETUP SK PLN menu.

By specifying the Use Prev option, you are using the previous sketching plane that was
defined for the previous feature. A red arrow is displayed on the planar surface and points
in the direction of feature creation.

4. Flip the red arrow by choosing the Flip option to make the arrow point in the direction
shown in Figure 4-75.
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m5. Choose Okay from the DIRECTION submenu.

As you choose the Okay option, the system takes you to the sketcher environment.

Creating and Dimensioning the Sketch for the Last Feature
The sketch of this feature consists of three lines. The bottom edge of the sketch is aligned with
the top edge of the base feature and the left edge is aligned with the right edge of the third
feature. When this sketch is extruded, it creates a rib shape.

1. Draw the section sketch using various sketcher tools as shown in Figure 4-76.

The sketch is dimensioned automatically and some weak dimensions are assigned to it.
You can add the required constraints to align the lines and points in the sketch with the
other features as shown in Figure 4-76. In the figure, the constraint symbol displayed on
the line indicates that the edges of the adjacent features are used to close the section.

2. After the sketch is complete, choose the Continue with the current section. button.
The SPEC TO menu is displayed and you are prompted to specify the depth of
extrusion. Using the CTRL+middle mouse button orient the model as shown in
Figure 4-77.

3. The Blind option in the SPEC TO menu is selected by default. Choose Done.

The Message Input Window is displayed with the default value.

4. Enter a value of 12 in the Message Input Window and press ENTER. The feature is
completed and it can now be previewed.

5. Choose the Preview button from the PROTRUSION dialog box.

Figure 4-77  Arrow showing the direction of
material addition

Figure 4-76  Sketch and constraints for the last
feature
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6. Choose OK from the PROTRUSION dialog box to exit it.

The default view of the model, when you choose the Default option from the Saved view
list button from the View toolbar, is shown in Figure 4-78.

Note
The last feature of this tutorial can also be created using the Rib option. The Rib option will be
discussed in Chapter 5.

Saving the Model
1. Choose the Save the active object button from the File toolbar and save the model. The

order of feature creation can be seen from the Model Tree shown in Figure 4-79.

In this tutorial you will create the model shown in Figure 4-80. This figure also shows the front
view, the top view, and the right-side view of the solid model.    (Expected time: 45 min)

The following steps outline the procedure for creating this model:

a. First examine the model and then determine the number of features in it, see Figure 4-80.
The model is composed of three features: one on the left (base feature), one in the middle,
and one hollow cylindrical feature with a hole.

b. Select the sketch plane for the base feature, draw the sketch using the sketching tools,
apply the dimensions and constraints, and then extrude the sketch to the given depth, see
Figure 4-82.

c. Select the sketch plane for the middle feature, draw the sketch using the sketching tools,

Figure 4-78  Completed model for Tutorial 2 Figure 4-79  Model Tree for Tutorial 2

Tutorial 3
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apply the dimensions and constraints, and then extrude the sketch to the given depth, see
Figure 4-87.

d. To create the hollow cylindrical feature, create a datum plane on the fly. Then draw the
sketch, apply the dimensions and constraints, and then extrude the sketch to the given
depth, see Figure 4-92.

The working directory is already selected in Tutorial 2 and therefore you do not need to
select it again. However, if you want to select the c04 directory, choose File > Set Working
Directory and then select c04 in the Select Working Directory dialog box.

Creating New Object File
1. Open a new part file and name it as c04tut3.The three default datum planes are

displayed on the graphics screen if the Datum planes on/off button is turned on. The
Model Tree is not displayed on the graphics screen as its display was turned off in the
first tutorial.

Figure 4-80  Top, front, right-side, and isometric views of the model



4-44      Pro/ENGINEER for Designers
©

 C
A

D
C

IM
 T

©
 C

A
D

C
IM

 T
©

 C
A

D
C

IM
 T

©
 C

A
D

C
IM

 T
©

 C
A

D
C

IM
 T

e
ch

n
o

lo
g

ie
s,

 U
S

A
e

ch
n
o

lo
g

ie
s,

 U
S

A
e

ch
n
o

lo
g

ie
s,

 U
S

A
e

ch
n
o

lo
g

ie
s,

 U
S

A
e

ch
n
o

lo
g

ie
s,

 U
S

A
. 

F
. 

F
. 

F
. 

F
. 

F o
r 

o
nl

in
e

 t
ra

in
in

g
, 

co
nt

a
ct

 s
a

le
s@

ca
d

ci
m

.c
o

m
o

r 
o

nl
in

e
 t

ra
in

in
g

, 
co

nt
a

ct
 s

a
le

s@
ca

d
ci

m
.c

o
m

o
r 

o
nl

in
e

 t
ra

in
in

g
, 

co
nt

a
ct

 s
a

le
s@

ca
d

ci
m

.c
o

m
o

r 
o

nl
in

e
 t

ra
in

in
g

, 
co

nt
a

ct
 s

a
le

s@
ca

d
ci

m
.c

o
m

o
r 

o
nl

in
e

 t
ra

in
in

g
, 

co
nt

a
ct

 s
a

le
s@

ca
d

ci
m

.c
o

m

Selecting the Sketching Plane for the Base Feature
To create the sketch for the base feature, you first need to select the sketching plane. In this
model, you need to draw the base feature on the FRONT datum plane because the direction
of extrusion is perpendicular to the FRONT datum plane.

1. Invoke the Extrude option from the menu bar by choosing Insert > Protrusion > Extrude.
The ATTRIBUTES menu is displayed.

2. The One Side option in the ATTRIBUTES menu is selected by default. Choose Done.

The One Side option will extrude the sketch to one side of the sketching plane. You will
now be prompted to select or create a sketching plane.

3. Select the FRONT datum plane as the sketching plane.

A red arrow is displayed on the FRONT datum plane and it points in the direction of
feature creation.

4. Choose Okay from the DIRECTION submenu. The SKET VIEW submenu is displayed.

5. Select Right from this submenu and choose the RIGHT datum plane from the graphics
screen.

The RIGHT datum plane is selected in order to orient the sketching plane. As you choose
the RIGHT datum plane, the system takes you to the sketcher environment.

Specifying References
In the sketcher environment, the References dialog box is displayed. The status displayed in
the Reference status area is Fully Placed. Close this dialog box.

Creating and Dimensioning the Sketch for the Base Feature
From the model, the section to be extruded for the base feature is evident. The section sketch
is shown in Figure 4-81. When this sketch is extruded, it will create the base feature.

1. Draw the section sketch using various sketcher tools as shown in Figure 4-81.

2. The sketch is dimensioned automatically and some weak dimensions are assigned to it.
Add the required constraints and modify the weak dimensions as shown in Figure 4-81.

3. Choose the Continue with the current section. button. The SPEC TO menu is
displayed and you are prompted to specify the depth of extrusion.

4. Choose the Default option from the Saved view list button of the View toolbar.

The default view is displayed which gives you a better view of the sketch in the 3D space.
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mA red arrow is also displayed on the model, indicating the direction of extrusion.

5. The Blind option in the SPEC TO menu is selected by default. Choose Done.

The Message Input Window is displayed with a default value in it.

6. Enter a value of 60 in the Message Input Window and press ENTER.

7. Choose the Preview button from the PROTRUSION dialog box and then choose OK.

The base feature is completed as shown in Figure 4-82. You can use the CTRL+middle
mouse button to spin the model to view it from different directions.

Selecting the Sketching Plane for the Second Feature
The next feature is an extruded feature. The sketching plane for this feature is the top planar
surface of the base feature.

1. Invoke the Extrude option from the menu bar. The ATTRIBUTES menu is displayed.

2. Select the One Side option from the ATTRIBUTES menu and choose Done.

You are now prompted to select or create a sketching plane.

3. Select the top planar surface of the base feature shown in Figure 4-83 as the sketching
plane. A red arrow that points in the direction of feature creation is displayed on the
planar surface.

4. Use the Flip option to flip the red arrow to point in the direction shown in Figure 4-83.

5. Choose Okay from the DIRECTION submenu. The SKET VIEW submenu is displayed.

Figure 4-82  Base feature of the modelFigure 4-81  Sketch with dimensions and
constraints for the base feature
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Figure 4-85  Sketch with dimensions and constraints

6. Select Right from this submenu and choose the planar surface highlighted on the model
shown in Figure 4-84.

By selecting the right planar surface of the base feature, the model will be oriented in such
a way that the highlighted planar surface will be at the right while drawing the sketch.
When you select the surface, the system takes you to the sketcher environment.

Creating and Dimensioning the Sketch for the Second Feature
The next feature to be created is an extrude feature. The section for the extrude feature is
shown in Figure 4-85. Before drawing the sketch, turn the model display to No Hidden.

1. Close the References dialog box that is
displayed on the top right corner of the
screen.

2. Draw the section sketch using various
sketcher tools. In the sketch, draw a
center line passing through the centre
of the arc as shown in Figure 4-85. This
center line helps in dimensioning the
sketch. Add the required constraints and
dimensions to the sketch as shown in
Figure 4-85.

Before exiting the sketcher environment,
turn the model display to Shading.

3. Choose the Continue with the current section. button. The SPEC TO menu is
displayed and you are prompted to specify the depth of extrusion. Use the
CTRL+middle mouse button to orient the model as shown in Figure 4-86.

Figure 4-84  Planar surface of the base featureFigure 4-83  Arrow pointing from the sketching
plane in the direction of feature creation
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m4. The Blind option in the SPEC TO menu is selected by default. Choose Done.

The Message Input Window is displayed with a default value in it.

5. Enter a value of 10 in the Message Input Window and press ENTER.

6. Choose the Preview button from the PROTRUSION dialog box.

7. Now, choose the OK button from the PROTRUSION dialog box to confirm the feature
creation and to exit the dialog box. The default trimetric view of the extruded feature is
shown in Figure 4-87.

Creating a Datum Plane for the Last Feature
To create the hollow cylindrical feature, you require a datum plane. This datum plane will be
created at an offset distance of 10 from the bottom surface of the second feature shown in
Figure 4-88. The datum plane will be created on the fly.

Note
The other method to create this feature is to select the top planar surface of the second feature as
the sketching plane and extrude the sketch at both sides of the sketching plane. The depth of
extrusion will be different at both the sides. If you use this method to create this cylindrical feature
then you do not need to create a datum plane.

1. Choose Insert > Protrusion > Extrude from the menu bar. The ATTRIBUTES menu is
displayed.

2. Select the One Side option from the ATTRIBUTES menu and choose Done.

You will now be prompted to select or create a sketching plane. You will create a sketching
plane.

Figure 4-86  Arrow showing the direction of
material addition

Figure 4-87  Model with the second extruded
feature
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3. Choose Make Datum from the SETUP PLANE submenu. The DATUM PLANE submenu
is displayed.

4. Choose the Offset option from the DATUM PLANE submenu.

When you choose the Offset option, the Plane and the Coord Sys options in the submenu
are highlighted and the system prompts you to select either a coordinate system or a
plane.

5. Spin the model using the CTRL+middle mouse button and then using the left mouse
button, select the planar surface shown in Figure 4-88.

As you select the planar surface from the second feature, the OFFSET submenu is displayed
and you are prompted to select a location or enter a value for the datum plane to pass
through.

6. From the OFFSET submenu, choose the Enter Value option.

A green colored arrow is displayed on the selected planar surface as shown in Figure 4-88
and the Message Input Window is displayed with a default value. You are prompted to
enter a value in the direction shown by the arrow. The arrow shows the direction of datum
plane creation.

7. Enter a value of 10 in the Message Input Window and press ENTER. Choose Done from
the DATUM PLANE submenu.

Datum plane DTM1 is created as shown in Figure 4-89 and will be selected as the sketching
plane for creating the sketch. A red arrow is attached to DTM1 that shows the direction
where the feature will be created with respect to the datum plane.

8. Select Flip and then choose Okay from the DIRECTION submenu. The arrow should
point in the direction shown in Figure 4-89.

The SKET VIEW submenu is displayed. Using this menu you will specify how the FRONT
datum plane should be oriented while drawing the sketch.

9. Select the Bottom option from the SKET VIEW submenu and then choose the FRONT
datum plane from the graphics screen. The system takes you to the sketcher environment.

Creating and Dimensioning the Sketch for the Last Feature
The sketch for the hollow cylindrical feature will be drawn on the datum plane DTM1. The
sketch for the hollow cylindrical feature consists of two concentric circles. Before drawing the
sketch, turn the model display to No Hidden.

1. Close the References dialog box that is displayed on the top right corner of the screen.
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2. Draw the section sketch using various sketcher options and add the required constraints
and dimensions to it as shown in Figure 4-90.

3. Choose the Continue with the current section. button. The SPEC TO menu is
displayed and you are prompted to specify the depth of extrusion. Now, turn the
model display to Shading.

Use the CTRL+middle mouse button to orient the model as shown in Figure 4-91. This
view gives you a better view of the sketch in the 3D space.

4. The Blind option is selected in the SPEC TO menu, choose Done.

The Message Input Window is displayed with a default value in it. A red arrow is also
displayed on the model.

Figure 4-89  Arrow showing the direction of
feature creation

Figure 4-88  Arrow showing the direction of
feature creation

Figure 4-91  Arrow showing the direction of
material addition

Figure 4-90  Sketch with dimensions and
constraints
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Figure 4-93  Model Tree for Tutorial 3Figure 4-92  Complete model for Tutorial 3

Self-Evaluation Test

5. Enter a value of 60 in the Message Input Window and press ENTER.

6. Choose the Preview button from the PROTRUSION dialog box.

7. Now, choose the OK button from the PROTRUSION dialog box to confirm the feature
creation and to exit the dialog box. The default trimetric view of the complete model is
shown in Figure 4-92.

Saving the Model
1. Choose the Save the active object button from the File toolbar and save the model.

The order of feature creation can be seen from the Model Tree shown in Figure 4-93. The
feature id numbers that are displayed in the Model Tree may be different when you create
the features.

Answer the following questions and then compare your answers to the answers given at the
end of this chapter.

1. You can change the default names assigned to the datum planes. (T/F)

2. Datum points are also used to associate note in the drawings and attach datum targets.
(T/F)

3. The constraint combination of creating an offset plane through cylinder is a valid
combination. (T/F)

4. In Pro/ENGINEER, all the features in a model can be created on a single sketching plane.
(T/F)
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6. When you create a datum plane using the __________ option from the SETUP PLANE
menu, the datum plane created is neither visible on the graphics screen nor is visible in
the Model Tree after the feature is completed.

7. Datum axis is an __________ axis that is created in Pro/ENGINEER.

8. The __________ view of the model is displayed when you choose the __________ option
from the Saved view list button.

9. When you create a new object file, __________ default datum planes are displayed on
the graphics screen.

10. The default datum planes in the Part mode are named as __________, __________, and
__________.

Answer the following questions:

1. Which one of the following is not a type of datums available in Pro/ENGINEER?

(a) Axis (b) Plane
(c) Circle (d) Curve

2. How many methods are available in Pro/ENGINEER to create a datum plane?

(a) One (b) Two
(c) Three (d) Four

3. Which one of the following menus is displayed when you choose the Continue with the
current section. button from the Sketcher Tools toolbar while extruding a section sketch?

(a) DIRECTION (b) SPEC TO
(c) SETUP PLN (d) None

4. Which one of the following combinations of keys and mouse buttons can be used to spin a
model on the graphics screen?

(a) CTRL+ALT (b) CTRL+middle mouse button
(c) CTRL+ENTER (d) CTRL+right mouse button

Review Questions
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Exercises

Exercise 1

5. Which one of the following menus is displayed when you invoke the Extrude option from
the menu bar?

(a) SKET PLN (b) DIRECTION
(c) ATTRIBUTES (d) None

6. Datum planes are considered as feature geometry and have mass and volume. (T/F)

7. To set the default orientation of the model to isometric, you have to use the Environment
dialog box. (T/F)

8. Generally, the sketching plane for the base feature of any model is decided after viewing
the isometric view or the drawing views of the model. (T/F)

9. Datum planes are used as a reference for mirroring features, copying features, for creating
a cross-section, and as well as for orientation of references. (T/F)

10. Unlike the datum planes constraint options, all the datum axes constraint options are
standalone. (T/F)

Create the model shown in Figure 4-94. The dimensions, front view, and right side view of the
model are shown in Figure 4-95.    (Expected time: 45 min)

Figure 4-94  Isometric view of the model
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Exercise 2
Create the model shown in Figure 4-96. The dimensions, the front, top, right-side, and isometric
views of the model are also shown in the figure.   (Expected time: 45 min)

Figure 4-95  Front view and right-side view of the model

Figure 4-96  Top, front, right-side, and isometric views of the model
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m Create the model shown in Figure 4-97. The dimensions, the top view, front section view,
and right section view of the model are shown in Figure 4-98.        (Expected time: 1 hr)

Exercise 3

Figure 4-98  Top view, front section view, and right section view of the model

Figure 4-97  Isometric view of the model
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Create the model shown in Figure 4-99. The dimensions, the top view, front section view, and
the two auxiliary views of the model are shown in Figure 4-100.       (Estimated time: 1 hr)

Exercise 4

Figure 4-100  Top view, front section view, and the two auxiliary views of the model

Figure 4-99  The 3D view of the model
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Exercise 5
Create the model shown in Figure 4-101. The dimensions, the left-side view, auxiliary view,
front view and isometric view of the model are also shown in the figure.

  (Expected time: 45 min)

Answers to the Self-Evaluation Test
1 - T, 2 - T, 3 - F, 4 - F, 5 - T, 6 - Make Datum, 7 - imaginary, 8 - trimetric, Default, 9 - three,
10 - TOP, FRONT, RIGHT.

Figure 4-101  Left-side view, auxiliary view, front view, and isometric view of the model


